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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Cat. N2: ABOX-104-001-71
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machine, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.

Cat. N2: ABOX-104-001-71
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Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

Performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model nhumbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

Cat. N2: ABOX-104-001-71
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESS
OR IMPLIED, REGARDING MERCHANABILITY, NON-INFRINGEMENT, OR
FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. ANY BUYER OR
USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE HAS DETERMINED
THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANY, NEGLIGENCE, OR STRICT LIABILITY.

If no event shall the responsibility of INDUSTRIAL SHIELDS for any act exceed the
individual price of the product on which liability is asserted.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.

Cat. N2: ABOX-104-001-71
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1 ARDBOX

A compact PLC based in Open Source Hardware technology. With different
Input/Outputs Units.

INDUSTRIAL SHIELDS

Supply Voltage

24 \/cc

Compact

COMPACT PLC ARDUINO ARDBOX 20 I/Os
RELAY HF

Fuse protection (2.5A)

Alimentation Voltage 12 to 24Vdc Polarity protection
Max. current consumption 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB
Communications 12C —USB - RSSPZISZ - RS485 -
TOTAL Input points 10
10

TOTAL Output points

Digital range:5 to 24 Vdc (3.8 to

25.4 Vdc)
INPUTS
Analog range: 0 to 10 Vdc
5 to 24Vdc
Digital 10 | min: 3/6 mA

Separated PCB ground

Analog 10 bits

6 of 10 Digital input

0 to10V
Input Impedance: 39K
Separated PCB ground

* Interrupt HS

4 of 10 Digital input

5 to 24Vdc

Cat. N2: ABOX-104-001-71
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I min: 5/10 mA
Separated PCB ground

Digital Isolated range: 5 to 24 Vdc
OUTPUTS (4.6 to 25.4 Vdc)
Analog range: 0 to 10 Vdc

Imax: 5A

Relay 8 (See Relay
Specification in i/o
technical details)

0to 10 Vdc
Analog 8 bits 2 | max: 40 mA
Separated PCB ground

*_ * _ * _ _
1/Os Expandability 12C"— RS232 USRBS485 SPI
Digital
Analog Reference |S.AB20REL.HF

* By using this type of signal you can no longer use Digital signal
You must read product Datasheet.

2 Precautions

3.1. Arduino Board
All Ardbox family products use Arduino LEONARDO Board.

3.2. Intended Audience
This manual is intended for technicians, which must have knowledge of electrical
systems.

3.3. General Precautions
The user must operate the product according to the performance specifications
described in the operation manuals.

Before using the product under conditions, which are not described in the manual or
applying the product to nuclear control systems, railroad systems, aviation systems,
vehicles, combustion systems, medical equipment, amusement machines, safety
equipment and other systems, machines, and equipment that may have a serious
influence on lives and property if used improperly, consult your INDUSTRIAL SHIELDS
representative.

Make sure that the rating and performance characteristics of the product are sufficient
for the systems, machines, and equipment, and be sure to provide the systems,
machines, and equipment with double safety mechanisms.

This manual provides information for programming and operating the Unit. Be sure to
read this manual before attempting to use the Unit keep this manual close at hand for
reference during operation.

Cat. N2: ABOX-104-001-71
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3 Technical Specifications

3.1 General Specifications:

Power supply

voltage DC power supply

12 to 24Vdc

Operating

voltage range DC power supply

11.4 to 25.4Vdc

capacity

Power
consumption DC power supply 30VAC max.
External Power supply voltage 12 to 24Vvdc
power supply
Power supply output 1.3A

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth
terminal.

Dielectric strength

2.300 VAC at 50 to 60 HZ for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 45°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage)

-20° to 60°C

Power supply holding time

2ms min.

Weight 340g max.
3.2 Performance Specification:
Arduino Board ARDUINO LEONARDO
Control method Stored program method
1/0 control method Combination of the cyclic scan and immediate refresh processing methods.

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
Programming language composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutoria/HomePage

Microcontroller ATmega32u4

Cat. N2: ABOX-104-001-71
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Flash Memory 32kb of which 4 kb are used by bootloader
Program capacity (SRAM) 2.5kb
EEPROM 1kb
Clock Speed 16MHz

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.

Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X
Settings  Network:
Sketchbool: location:

C:\Users\Albert\Documents\Arduina Browse

Editor language: English (English) ~ | (requires restart of Arduina)
Editor font size: 15

Interface scale: [] Automatic | 100 =%  (requires restart of Arduino)

Show verbose output during: [] compilation upload

Compiler warnings: None -

[pisplay line numbers

[JEnable Code Folding

Verify code after upload

[Juse external editor

Check for updates on startup

Update sketch files to new extension on save (.pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs:  http://apps. industrialshizlds.com/main/arduina fboards fpackage_industrialshields_inde: 0
Mare preferences can be edited directly in the file
C:\Users\albert\AppDataocal\Arduino15\preferences. tet

ecit only when Arcuino is not running)

Ok Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

N
i
[«D]
&
[a W}

Cat. N2: ABOX-104-001-71
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3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch_mar16a | Arduino 180

File Edit Skewh Tools Help

Auto Format Cul+T
Archive Sketch
sketch_mar Fix Encoding & Reload

Senal Monstor Ctrl +Shaft+M
Senal Plotter Cul+ShittsL
WiFI101 Firmware Updater
Boarck "M-Duino family” 3 Baards Manager..
Inchustrial Steelcls: “W-Duino 58+ 3 Arduino AVR Boarck

ot Asduin Yiin
Get Board Info Arduino/Geneano Una

Archiino Duemilanove or Diecimila

) Programmer. “Archino as ISP 3
Burn Bootloader

Arduino Nano
Asduino/Geneano Mega of Mega 2560
Ascluin Mega ADK

Arduino Leonardo

Arduine Leonardo ETH

Archuing/ Genuano Micro

Arduing Esplora

Ardino Mini

Arduino Ethernet

Arduino Fio

Ascluino BT

LilyPad Ardino USE

LilyPad Arcuino

Arduine Pro o1 Pro Mini

Ascluin NG of older

Arduino Robat Control

Arduine Robat Motor

Arching Gemma

Adatruit Circuit Playground

Ascluine Yuin Mini
Arduino Industrial 101

Linino One
A

* | M-Duino family

5. Search for industrialshields on the searcher.

& Boards Manager x
Type All ~ | lindustrialshields
industrialshields ~

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

Tt Install

Close

6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

Cat. N2: ABOX-104-001-71
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@ sketch mar16a | Arduing 180

File Edit Skewth Tools Help

Auto Format
Archive Sketch
sketch_mart Fix Encading & Reload
. Serial Monitor Ctrl oShifteld
, . Senal Plotter Cu+shiteel

Wi 101 Firm wase Updater

Boardt “Asduina Yiin' 3 Boards Manager.
Port chino AVR Boards
Get Board Info ® Arduine Yon

Arcino/ Genuino Uno

Archino Duemilanove or Diecimila
Archino Nano

Arckano/Genuino Mega o Mega 2560
Arckino Mega ADK

Archino Leonardo

Arckino Leonarclo ETH

Arduano/ Genuino Micro

Arcino Esplora

Aeckino Mini

Archino Ethernet

Arckano Fio

Archino BT

LilyPad Archiing USE

LilyPad Arching

Arckino Pro of Pro Mini

Arckino NG or older

Asckino Robot Control

Arcino Robot Motor

Arckano Gemma
Adalrat Circut Playgroune!

Arcking Yun Mini

Pragramm er; “Arduno as ISP
) Bum Bootioader

- o *

- _

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools:

There, it can be selected the exact model for every family.

@ sketch_mari6a | Arduing 180
File Edit Sketch Tools Help

Auto Format
Archive Sketch
sketch_mart Fix Encoding & Reload
. Serial Monitor Ctrl+Shitteld
ot Serial Plotter Corl+ShiftsL.

WIFi 101 Firmwrare Updater

Board: “Asdbox family”

Inchustial Stuelds: “Ardbox Analog™ 38 Andbox Anslog

Port Ardbex Analog HF

put GetBoard Info Ardbax Relay

Ardbox Relay HF legacy)
Ardbax Relay HF v/ HW RS-485
Ardbox Relay HF w/ HW RS-232

N Programm er: "Arduing as 5P
Bumn Bootioader

- =] %

- _

Also there are some examples of programming in File -> Examples -> Ardbox Family.

Furthermore there are some extra libreries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

Cat. N2: ABOX-104-001-71
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5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Ardbox Family use micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox Family

- Select the correct Ardbox Relay Board.

@ sketch_mari6a | Arduino 180
File Edit Sketch Tools Help
Auto Format cut+T
Archive Sketch
sketch_mar! Fix Encading & Reload
Serial Monitor Col+Shiftel
Serial Plotter Cut+Shiftl

Wi 101 Firm wase Updater

Board “Ardbox family”
Incustial Stelds: “Arcbox Relay HF wj HW RS-232" § Ardbox Analog
port 3 Ardbax Analog HF
Get Board Info Ardbax Relay
Ardbox Relay HF (legacy)
Ardbox Relay HF w/ HW RS-485
# Ardbox Relay HF w/ HW RS-232

) Programm er: “Arduino as ISP
Burn Bootioader

If it is used the latest version of Industrial Shields boards it will appear 4 different Ardbox Relay
boards:

The ones that have to be used for the 104-001-71 Ardbox Relay HF are the following ones:

e Ardbox Relay HF w/ HW RS-485
e Ardbox Relay HF w/ HW RS-232

* HW is the abbreviation of Hardware, so depending on the Hardware Serial it will be used, it is
needed to select one or the other. See section 11 to configure the equipment to work with RS-
232 Hardware Serial or RS-485 Hardware Serial.

If it is not used the RS-232 & RS-485 it is needed to select the board Ardbox Relay HF w/ HW
RS-485. See section 9-10 to enable the features that are disabled if using RS-485 protocol that
will get enabled as there is no RS protocol.

Cat. N2: ABOX-104-001-71
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- Select correct port.

D st maeto | Arduing 120 - 8 x
File Edt Skeich Tools Help

Auto Format et

Archive Sketch

Fix Encoding & Reload

Senal Maritor CtrleShiftsM ~
Senal Plomer Cteshiftel

WIF 101 Firmware Lipdater
Boact “Ardbox tamily”
Inchustrial Shieids: “Ardbax Analog”

i Senal ports
© ¥ GetBaadinio COM13 (Aackin Leonardol

Programmes; “Arcana s I5P"
Bum Bootioager

Now everything is set up to upload a sketch to Ardbox Relay HF

6 How to connect PLC to power supply

- Ardbox Family PLCs are 12 to 24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.
- Make sure that the power supply mains output is not higher than 24Vdc.

|::"."x' ER SUP PLT]
__ ‘ u
u 4

. | GND |
b |—1: 24Vee |
-

Cat. N2: ABOX-104-001-71
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- Suggested power suppliers

i

LT
0
L ]
e
* Not recommended for industrial applications. The e ]
Jack connector needs to be removed and use the live
and GND connectors. L %

q

Din RAIL Power Supply, ac-dc,
30W, 1 Output 1.3A at 24Vdc

7 Ardbox Relay HF 1/0 Pinout:

7.1 Zone Connections

Page 1 7

LEFT ZONE
oN oF Switch config*
NC (see section 9 for Communications
Base gg'?;c”l' configuration. Enabling Communications
(common unit) 10.0/ SDA disables some 1/0Os)
ON OFF
RE-RS5485
104
LEFT ZONE DE-RS485
10.5
= shl £ MISO Communications pinout
g aIlawn c Mos! q
58 |g9les s scx
o g S| 5 o RESET
Ts Bu By 5 5Vdc
<O x| < o gnp
MISO 14 | 14 SPI-MISO %’: ms22
MOSI 16 | 16 SPI-MOSI SoAPNZ ] &
ScK 15 | 15 SPI-CLOCK scLPINg ] §
RESET - - SPI-RESET
5vdC - - 5V Output Relay Outputs
GND - - GND vy Pute
RX-RS-23212 | 1 | 4 Serial/lRS232
TX-RS-23212 | 0 | 8 Serial/RS232
SDA-PIN2! 2 | 2 12C/SPI SS
SCL-PIN3! 3 | 3 12C/SPI SS
Rl 10 |10 Relay 1 Out Power supply connectors
R2 9 9 Relay 2 Out (24vVdc - Gnd)
R3 6 6 Relay 3 Out
GND - - GND R
&
24V - - - GND é%
24V |3
HS*: Hardware Serial
SS*: Software Serial

1 See section 9 to enable these connections
2 See section 10 to enable these connections

Cat. N2: ABOX-104-001-71
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Base
(common unit)
RIGHT ZONE
RIGHT ZONE —
| enlen ggg.; RS-485 pinout .
elaIT|acc - £g<° Analog Outputs Pinout
x 3 ow| ow o
o Co| E® p=
SE| 3|35 S
Ts| Bl By 5
< O X | <X L
B- - - RS485 ¥ ,. Relay Outputs
A+ - RS485 R84
Z-/A0.1 11 - RS485/Analog Output B o]
Y+/A0.0 | 13 - RS485/Analog Output FOe—| 108
B~ | 10.7
R4 5 Relay 4 Out (Qe— | 10.6
e—| 105"
R5 3 Relay 5 Out B 04" .
10.9 A5 A5 Analog/Digital Input _ oo Inputs pinout
& [o~e—|[li02
10.8 A4 A4 Analog/Digital Input c to~e—|[f10.1
2 Lo~ Moo
10.7 A3 A3 Analog/Digital Input S L {—awo
om
10.6 A2 A2 Analog/Digital | t 9 €
nalog/| |g| al Inpu 2 § RG{
10.5 Al Al Analog/Digital Input & = —
= B
P o Lo —_
10.4% A0 A0 Analog/Digital Input “;'i:" E =3 R?lr Relay Outputs
Fa i @mdi°csS (.
10.32 Digital Input/ Interrupt TLgoD
b 2F 872
10.22 4 4 Digital Input/ Interrupt 3 § ; 2 8 "_
01 12 12 Digital Input/ Interrupt | g é ?D 8 ‘9_3"_ REA
10.0t 2 2 Digital Input/ Interrupt —
R6 7 7 Relay 6 Out
R7 0 0 Relay 7 Out
1 1 Relay 8 Out
Rg! Y
[
o o w =T o (=] E
~ w0 o T 5 g o o o o w %E
00 O OpQ1es0 OO0 O (‘g 45
7 sl £ — | — Sy
io o oligllofo oo o W L
P ~ ~ 5 2 5/8 ¢ 5 v RESE\
(=] (=] [=] o o [=]
Config switch *
(see section 9 for communications
configuration)
Power LED Arduino Reset button
Input / Output
LED

Cat. N2: ABOX-104-001-71
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8.1 General Switches Configurations

LEFT ZONE

Communications and inputs/outputs can not work simultaneously.

LEFT ZONE
SWITCH ON OFF
NC
HIF Half Duplex Full Duplex
SCL/R5 R5 SCL
SDA/I10.0 10.0 SDA
RE-RS485 RE-RS485 10.4
10.4 10.4 RE-RS485
DE-RS485 DE-RS485 10.5
10.5 10.5 DE-RS485

1. NC-Not Connected

ON
NC

ON

10.4

Half / Full we

Cupien
R5/8CL
10.0/ SDA -

RE-RS488 | -

DE-R8485 ’i

10.8 -

2. H/F — Choosing between Half/Full Duplex for the RS485 communication. In order to use Full
Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE(*see section 10).

3. SCL/R5 — Choosing between SCL (12C) and R5. If the switch is ON, the R5 will be enabled and the
SCL will be disabled. If the switch is OFF, SCL will be now enabled and R5 disabled.

4, SDA/10.0 - Choosing between SDA (I12C) and 10.0. If the switch is ON, the 10.0 will be enabled
and the SDA will be disabled. If the switch is OFF, SDA will be now enabled and R5 disabled.

1. RE-RS485 — If this switch is ON, the 10.4 switch must be set to OFF. Being in ON mode it enables
RE for the RS-485.
2. 10.4 —If this switch is ON, the RE-RS485 switch must be set to OFF. Being in ON mode it enables
the input 10.4.
3. DE-RS485 — If this switch is ON, the 10.5 switch must be set to OFF. Being in ON mode it
enables DE for the RS-485.
4. 10.5 — If this switch is ON, the DE-RS485 switch must be set to OFF. Being in ON mode it
enables the input 10.5.

TOP ZONE.
TOP ZONE
SWITCH ON OFF
D1 - RS-485 RS-232/485 R8
R8 R8 RS-232/485
DO - RS-485 RS-232/485 R7
R7 R7 RS-232/485

Communications and outputs can not work simultaneously.
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1. D1 -—RS-485: If this switch is ON, the R8 switch must be set to OFF. Being in ON mode it
enables DI for the RS-485 and RS-232 Hardware Serial ( see section 9 for jumper
configuration)

2. R8: If this switch is ON, the DI — RS-485 switch must be set to OFF. Being in ON mode it

enables the Relay 8.

3. DO — RS-485: If this switch is ON, the R7 switch must be set to OFF. Being in ON mode it
enables DO for the RS-485 or RS-232 Hardware Serial ( see section 9 for jumper
configuration)

4. R7: If this switch is ON, the DO — RS-485 switch must be set to OFF. Being in ON mode it

enables the Relay 7.

8.2 RS- 485 Switch configuration

TOP ZONE
SWITCH MODE
DI - RS-485 ON
R8 OFF
DO - RS-485 ON
R7 OFF
LEFT ZONE
SWITCH MODE
NC
HIF ON/OFF
SCL/R5
SDA/I0.0
RE-RS485 ON
10.4 OFF
DE-RS485 ON
10.5 OFF

RS-485 TOP ZONE: In order to enable the RS-485 protocol the
TOP ZONE must be configured as it is shown in the table.
Although the switch name only is referenced to RS-485 it is
also the same for the RS-232.

Having this set up, the R7 & R8 are disabled.

RS-485 LEFT ZONE: The H/F can be set up as ON or OFF. If it is wished
to use the RS-485 Half Duplex (A+, B-) it has to be ON. For using the
RS-485 Full Duplex (A+, B-, Y+, Z-) it has to be OFF.

The switch RE-RS485 and DE-RS485 must be set in ON mode. As
these pins are set to ON, the other 2 (10.4, 10.5) must be set to OFF.
Being in OFF mode they are completely disabled.

The switches marked as “ — “ don’t interfere with the RS-485

communication protocol.

* To enable the RS-485 communication it is needed to configure also the jumpers, see Section 10
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8.3 RS- 232 Switch configuration

TOP ZONE
SWITCH MODE
DI - RS-485 ON
R8 OFF
DO - RS-485 ON
R7 OFF
LEFT ZONE
SWITCH MODE
NC
HIF
SCL/R5
SDA/I0.0
RE-RS485 OFF
10.4 ON
DE-RS485 OFF
10.5 ON

RS-232 TOP ZONE: In order to enable the RS-232 protocol the
TOP ZONE must be configured as it is shown in the table.
Although the switch name only is referenced to RS-485 it is
also the same for the RS-232.

Having this set up, the R7 & R8 are disabled.

RS-232 LEFT ZONE: As both RS-232 & RS-485 can’t work at the same
time, the RE-RS485 and DE-RS485 have to be in OFF mode, so this
enables the 10.4, 10.5 inputs.

* To enable the RS-232 communication it is needed to configure also the jumpers, see Section 10

8.4 12C Switch configura

TOP ZONE
SWITCH MODE
DI - RS-485
R8
DO - RS-485
R7

tion

LEFT ZONE

SWITCH MODE
NC

HIF

SCL/R5 ON

SDA/I0.0 ON

RE-RS485

10.4

DE-RS485

10.5

To enable 12C configuration the switches SCL/R5 & SDA/10.0 must be set to ON. As they are in

ON mode R5 & 10.0 are disabled.

The switches marked as “ — “ don’t interfere with the 12C communication protocol.
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9 Jumper configuration

9.1 General jumper configuration

JUMPER ZONE 1

LEFT RIGHT
Y+ Z-
ENABLE ENABLE
A0.0 A0.1

JUMPER ZONE 2

LEFT RIGHT
10.2 10.3
D4 D8

RS-232 RS-232

JUMPER ZONE 3

uUpP RS-485

D1 | RS-232

DOWN | RS-485

DO | RS-232

This jumper zone makes the selection between using the RS-485 Full
Duplex or the Analog Outputs. If it is wanted to use the RS-485 Full
Duplex communication protocol the Y+ must be connected to ENABLE,
and Z- also connected to ENABLE. If it is wanted to use the Analog
Outputs, The A0.0 must be connected to ENABLE, and AO0.1 also
connected to Enable

This jumper zone makes the choosing between connecting the inputs
10.2, 10.3 to pins 4, 8 of the Arduino Leonardo respectively, or connect
the RS-232 ports to activate the Software Serial RS-232. In order to use
the inputs 10.2,10.3 the jumper must be connected to the pins 4,8. So
10.2 must be connected with D4 and 10.3 must be connected to D8.

This jumper makes the choosing between connecting MAX232 to pins
0,1 of the Arduino Leonardo or with the MAX485. In order to use the
RS-232 Hardware Serial protocol both RS-232 must be connected to
the D1/DO. In order to use the RS-485 Hardware Serial protocol both
RS-485 must be connected to the D1/DO0.

*The jumpers that are not connected to the middle jumpers MUST NOT be connected anywhere.
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10 Hardware Serial RS-232 & RS-485 Configuration

10.1 Hardware Serial RS-232
In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF

will be:

Switch configuration:

LEFT ZONE
SWITCH MODE
TOP ZONE NC
HIF
SWITCH MODE
SCL/R5
DI - RS-485 ON
SDA/I0.0
R8 OFF
RE-RS485 OFF
DO - RS-485 ON 04 oN
R7 OFF DE-RS485 OFF
10.5 ON
Jumper configuration:
JUMPER ZONE 1 JUMPER ZONE 2 JUMPER ZONE 3

LEFT RIGHT D1 | RS-232
LEFT RIGHT G Up NG
NC NG 10.2 10.3
ENABLE ENABLE D4 b8
DOWN | NC
A0.0 A0.1 NC NC DO | RS-232

Having configured Ardbox Relay HF as it is shown above, these are the features that are

available:

o Available communication protocols:
e Hardware Serial RS-232.
o |2C *If 12C is active R5 & 10.0 are disabled
e SPI|

Inputs: All 10 inputs, from 10.0 to 10.9. If using 12C 10.0 is disabled
Relay Outputs: From R1 to R6. If using 12C R5 is disabled. R7 and R8 are disabled from
the TOP ZONE switch.

o Analog Outputs: A0.0 & A0.1
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10.2 Hardware Serial RS-485
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In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF

will be:

Switch configuration:

LEFT ZONE
SWITCH MODE
TOP ZONE NC
H/F ON/OFF
SWITCH MODE
SCL/R5
DI - RS-485 ON
SDAVI0.0
R8 OFF
RE-RS485 ON
DO - RS-485 ON 10.4 OFF
R7 OFF DE-RS485 ON
10.5 OFF
Jumper configuration:
JUMPER ZONE 1 HALF DUPLEX JUMPER ZONE 2 JUMPER ZONE 3

LEFT

RIGHT

Y+

Z-

ENABLE

LEFT RIGHT D1 | RS-232
N h
10.2 10.3
b4 I

A0.0

ENABLE
A0.1

D8
NG NG DOWN | NC | g | Rs-232

JUMPER ZONE 1 FULL DUPLEX

LEFT

RIGHT

Y+

Z

ENABLE

[I ENABLE

A0.0

A0.1

o

Having configured Ardbox Relay HF as it is shown above, these
are the features that are available:

Available communication protocols:

e Hardware Serial RS-485.

o [2C

e SP

*If 12C is actived R5 & 10.0 are disabled

o Inputs: All 10 inputs except for input 10.4, 10.5 as they are disabled from the LEFT ZONE
switch. If using 12C 10.0 is disabled
o Relay Outputs: From R1 to R6. If using I2C R5 is disabled. R7 and R8 are disabled from

the TOP ZONE switch.

o Analog Outputs: A0.0 & A0.1 if RS-485 is working in Half Duplex. They are disabled if
using RS-485 Full Duplex, see the JUMPER ZONE 1 from above.
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11 I/0 technical details

Relay

B Contact Ratings

Load High-capacity
Rated load (resistive, p.L.= 1) T
Max. switching voltage 250 VAC, 30 VDC

Rated carry current
Max. switching current

5A
5A (AC load,) 3A (DC load)

Max. switching power 1,250 VA, 90 W
B Characteristics

Contact resistance (see note 2) 100 Ll .

Operate time 10 ms max.

Release time 10 ms max.

Insulation resistance (see note 3)

1,000 Mgz min. (at 500 VDC)

Dielectric strength

4,000 VAC, 50/60 Hz for 1 min. between coil and contacts
750 VAC, 50060 Hz for 1 min. batween contacts of same polarity

Impulse withstand voltage

10,000 V (1.2 x 50 ps) batween coil and contacts

Vibration resistance Dastruction: 10 to 55 Hz, 1.5-mm double amplitude
Malfunction: 101e 55 Hz, 1.5-mm double amplitude
Shock resistance Dastruction: 1,000 m/s® (approx. 100 G)
Malfunction: 100 m/s® (approx. 10 G)
Life expectancy Mechanical: 5,000,000 operations min. (18,000 operations/hour)
Elactrical: 200,000 operations minimum:
High-capacity Standard
5 A al 125 VAC 3 Aat 125 VAC
3 A at 30 VDC 3 Aat30vVDC
100,000 operations minimum:
High-capacity
5 A at 250 VAC

All electrical lzad ratings are resistive, with operation frequeney = 1,800 operaticns/hour.

Minlmum permissible load
(reference value) (see note 4)

5VDC. 10 mA

Amblent temperature Operating: =40°C 1o 70°C (with no icing or condensation)
Ambient humidity Operating: 5% to 85%
Weight Approx. 4 g

MNote: 1. The data shown above are initial value.

2. Measurement conditions: 5 VDC, 1 A, voltage drop method
3. Measurement conditions: Measured at the same poinis as the dieleciric sirength using a 500-VDC ohmmeter.
4. This value s for a switching frequency of 120 operations/minute. (P level: iy = 0.1 x 10* operations)

Standard models
Maximum Switching Capacity

10,

£
= 3
2 DC resistive \ ﬁ resistive
5 Ioad d
L&)
=]
5 i
=
Cantact
o resislance

o

Switching voltage (V)
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1 10 0 100 250 1,000

Electrical Service Life

T T
126 VAC, 30 VDT resistive load

% To—]

Sarvice Life { 104 operations)
2

Contact current (A)
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High-capacity models
Maximum Switching Capacity Electrical Service Life
0 100] :
250 VAl 30 VDO refistive laad J
- G0
— (=1
=, = o
= DT regigtive - ]
o laad = e
= |=]
3 & —
-E- '6 10|
& &
5 Comact k=] 5
o F.-sislru;r a
Z 3
0.1 1
10 a0 100 250 1,000 o 1 ] 4 5
Contact voltage (V) Contact current (A)
Standard models High-capacity models
Ambient Temperature vs. Maximum Coil Voltage Ambient Temperature vs. Maximum Coil Voltage
0 ‘g‘sl Sem: gSNBAk SANTIC @ ‘-ltr.lr‘:r"'r“ - GSNB-1AE, 24 VDL
Uneon- 4 antity lested: | y 0 jantity tested. 5
—_ " - @ N0 current
3 200§ tirmed s A s & iaa 4 ——— 3-Acurent
area : st il
& 1m0 S m )
a
b3 :'\..\\: % |
E 160 T == = T
8 ; g8 ; S~
E 140 ) E a0 |
3 : = |
E ! E i
é k= ] é |
= | = |
100 T 100 T
| |
80 1 80 !
0 2023 40 B 70 & 100 ) 2023 ) 60 70 80
Ambient temperature (°C) Ambient temperature (“C)

Note: The maximum coil voltage refers to the maximum value in a varying range of operating power voltage, not a continuous voitage.

Analog Out Turn
I

-on

]

AMALOGOUT
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log Out Turn-off
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ANALOG OUT

————
AMALOGIDIGITAL IM

CH1 F @,
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12 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MCO0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20

Cat. N2: ABOX-104-001-71
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13 ARDBOX Family Dimensions:

129
14

B el =

45mm width

Pagez 9

14 DIN rail mounting:

Profilato a coppello TH 35-7,5 Prafilato o coppello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
15 5
155,
" RO8
- B=03 Ros
]
=
(i
ST 1004
v Sezione A / Section A E
0.3 mo ~ l 2.2 min. finoa /To 2,5 mox
ﬁ -
B Sezione A/ Section A
CARATTERISTICHE METODO  UNMA'  BLEND FEATURES TEST UNITS  BLEND
DI MISURA PU/ABS METHOD PUABS
Mecconiche  Resisoreo o tzineollo srenomento AT D§38 MPo 68 Mechanicol fest Resistoce o 0t i 1A D
Resishzo o tozione g wttug KSTIAD638  MPo 4 Tensllesrength ASTMDE38 MRy 4
Ally MTMD638 % 9 Utiman'e elongt ASTMDE38 % 5
o in flesione [ D] P 4 Fering modulus ASTADT0 MRy 204
Provg 170d con infoglio 15018014 X" 55 rod test o 1S018014  Xufm' 55
Termiche Temp.di nmmolimento Viot metdoB AT DISIS °C 114 Thermal fest Vit sodtening ST DT i 14
Temperove Rictio 1 81 WPy KTmosds  °C 9 Rebecting temperctue 1 81 WPy ASTMDG48  °C 7
Fisiche Peso paifico KD gfand 121 Physical test  Spacific gmvity ASTADTS?  qy/nd Wil
Rii nello stompo K0S % 0408 Mol ik ASTMD9SS % 0405
Mt Flow Index 260°C - 98N KSTADIZB  gi10° 1l Mt Flow index 260°C - 98N ASTMDIZE g0 1R}
Comportamento Auesinguerea (mm di spesor) 094 - V-0(08) Flame fest Soff etinguisher (thidness in mm) o4 - V-0(08)
allo fiomma b Inondescen 32 mm 9521 °C 960 Ingondescente thiood 32 mm 169521 € 960

Italtronic si iserva il diitto di modificore il materiale con cui realizza i propri prodoti
senzo obbligo di preoviiso.
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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